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CONGRATULATIONS!

By opening the MONOPOLY" CD-ROM game, you
have opened the door to the newest way to play the
world’s most popular board game! The MONOPOLY®
CD-ROM game provides classic gameplay with state-
of-the-art, three-dimensional graphics that give you a
token’s-eye view of the board, and let you play with
millions of other people worldwide via the Internet.

MONOPOLY™, the distinctive design of the game board, the four
COrner squares, as well as each of the distincrivc elements of the board
and the playing pieces are trademarks of Hasbro, Inc. for its real estate
trading game and game equipment. ©1935, 1997 Hasbro, Inc.

©1997 Hashro Interactive, Inc., Beverly, MA 01915. All rights reserved.

We will be happy to hear your questions or comments about this game.
Whrite to: Consumer Relations, Hasbro Interactive,
P.O. Box 1012, Beverly, MA 01915.

For information on this product’s rating, please call 1-800-771-3772

QUICK START
Insert the MONOPOLY® CD-ROM game disc into your CD-ROM drive.

Start Windows.
From the File menu, select Run.

Type D:\SETUP in the dialog box. (Use your actual CD-ROM
drive letter.)

Follow the on-screen installation instructions.
After the installation is complete, click on the . icon.
Click once to skip the introduction.

At the end of the opening movie, click on the game board or select
New Game from the File menu.

From the game screen, click on Add Player I button.
Choose “Person on this computer...”

Type in your name and click OK.

Choose which token you want to use and click on it.
Click on Add Player 2 button.

Click on Add a Computer Al Player.

Choose Standard from the list that appears and click OK.
Select a token for Standard to use and click on it.

Click on GO to begin the game!




GETTING STARTED

MONOPOLY" CD-ROM Game System Requirements
COMPUTER: IBM 486/33 MHz (or 100% compatible)

MEMORY: Minimum 8 MB

WINDOWS: Windows® 3.1; Windows” for Workgroups 3.1;
Windows” for Workgroups 3.11; Windows” 95
DISPLAY: Minimum 640 x 480 display, 256 colors
HARD DISK: Minimum of 10 MB noncompressed space
CD-ROM: Minimum double-speed CD-ROM drive (quad-speed
recommended)
NETWORK: TCP/IP network protocol stack with a
WINSOCK.DLL v1.1 or equivalent
Windows 3.1 and Windows for Workgroups 3.1 players, please consult
your network card manufacturer for recommended TCP/IP drivers.

Windows for Workgroups 3.11 players can obtain Microsoft’s 32-bit
TCP/IP network protocol stack from Microsoft via their website:
http://www.microsoft.com or via their FTP site: ftp.microsoft.com.

Windows 95 players will find that Microsoft includes TCP/IP drivers for
many popular network cards.

ODEM: Minimum 14,400 baud, Hayes compatible

INTERNET: TCP/IP network protocol stack with WINSOCK.DLL
v1.1 or equivalent over SLIP/PPP dialup or direct
connection.

SETUP & INSTALLATION

S Insert the MONOPOLY® CD-ROM game
disc into the CD-ROM drive. Start
Windows. From the File menu, select
the Run option. In the dialog box, type
“D:\SETUP” and click on the OK
button. (Use your actual CD-ROM drive letter in place of “D:”.)

Follow the on-screen installation instructions.

Once the Setup is complete, you return to Windows. You will see the
Westwood Studios program group containing icons for the MONOPOLY®
game. You are now ready to play the game!

STARTING THE GAME

Double-click on . to begin the game. (If the CD-ROM is not in the
drive, you'll be asked to insert the disc.)

The game opens with a demonstration of the three-dimensional world
of the MONOPOLY®CD-ROM game. When you are ready to continue,
click the mouse. The MONOPOLY® game box springs open, an
excitement begins!




Click on the box top to leave the game.
Click on the rules booklet to review the
rules and get game help. Click on the
game board tostart a new game or continue
a saved session of the MONOPOLY"
CD-ROM game.
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BEGINNING A NEW GAME

arepan CooM EE  To play a game of

! ' MONOPOLY” CD-ROM on
your computer, collect a group
of up tosix players. Click on an
Add Player button. You may
choose to add yourself, a friend,
or computer opponent. You
may also host or join a local
area network (LAN) game.

If you host a LAN game,
remote players are not at your
computer. Remote players connect to your game by calling you. To call you
across the LAN, your friends will have to know your IP address. (See “How
to Find Your IP Address Using Windows" 95/98” on the next page.) Once all
LAN players have joined the game, you, as host, click on the GO button to
begin the game.
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NOTE: You can create your own customized computer players! See the
game’s online help for details on how to build your own computer opponent.




HOW TO FIND YOUR IP ADDRESS USING WINDOWS® 95/98

To find your IP address so that you can communicate it to other players,
follow the steps detailed below:

1)

2)

Connect to your ISP (Internet Service Provider).

This MUST be done before continuing.

Click on the START button on your Windows® 95/98
Task Bar, and then click on RUN.

When the RUN window appears, type “winipcfg”

(without quotes), and then click OK.

The box labeled “IP Address” is your IP address for that session.
Note: Your [P address may change each time you log on depending
on your ISP.

If you are hosting the game, you must communicate your current

IP address to the other players wishing to join the game. You can
do this via:

¢ E-mail — Use your e-mail program to send your IP address
to other players, OR

® Phone - Call the other players and tell them your IP address via
a second phone line, OR

¢ Chat or Instant Message Programs — Use programs such as ICQ
or AOL Instant Messenger to send your IP address to the other
players.

Note: For games that are playable on the MSN Gaming Zone (formerly
called Microsoft’s Internet Gaming Zone), IP address information is
automatically exchanged between players via the Zone.

Helpful Web Site Addresses
ICQ — http://www.mirabilis.com
AOQOL Instant Messenger — http://www.aol.com/aim/




CHOOSING GAME OPTIONS

When you begin a new session of the MONOPOLY® CD-ROM game, all of
the game options default to the official MONOPOLY® game rules. You can

customize some of these options for a fun, personalized game. Some of the

options you can change are:

v Free Parking collects fines

v Landing on GO doubles salary

v/ Have auctions

v/ Cash is hidden

¢ Transactions only on your turn

v Transactions allowed from Jail

v One lap required before purchasing
¢ Immunity from rent allowed in trades
v Infinite houses and hotels in Bank

You, as a game host, may change game options before starting a game.
For a LAN game, make any changes from the Options menu before
admitting any remote players. For an Internet game, options may be
negotiated between the host and remote players before gameplay begins.
Once the game has begun, any player may change a game option with
sent of all other players.

OPENING A GAME IN PROGRESS

To choose a saved game, click on Open a Game. You can save a game
in progress only when you have a group of friends playing on your
computer. A remote game can’t be saved while in progress.

CHAT FEATURE*

While playing on the Internet or a local area network, you are able to
send messages to other players. Click on the remote player’s token in
the players area of your computer. A dialog box will appear allowing
you to enter a message. It can be “whispered” only to the recipient or
“yelled” to all players.

*CHAT

Hasbro Interactive does not monitor, control, endorse, or accept responsibility for the
content of text or voice chat messages transmitted through the use of this product.
Use of the chat function is at your own risk. Users are strongly encouraged not to give
out personal information through chat transmissions.

Kids, check with your parent or guardian before using the chat function or if you are
concerned about any chat you receive.




AND WE'RE OFF!

Once you've added all of the players to the
game and agreed upon all the options, you're
ready to start playing. Click on the GO
button to begin the game. The computer
will roll dice for all of the players,
determining the order of play.

When it's your turn, click on the dice to
begin. Your token will move forward
according to the total shown on the dice.

When you land on a square, you'll have a chance to do all of the things
you normally do in the board version of the Monopoly® game. If you
land on a square that requires you to act, a dialog box appears with the

options available to you.

HEY! WAIT A MINUTE...

As you play the game, you may want to set up
a trade, or mortgage a property to raise some
cash. To interrupt another player’s turn, click
on your game token. At the next available
opportunity, the Interrupt dialog box appears,
and you can propose a trade, buy or sell
houses, or mortgage or unmortgage property.
Players may interrupt one at a time.

NOTE: The “next available opportunity” depends on the options you
have selected. Normally, you may transact business on your turn, or
between other players’ turns.

WHEELIN’ AND DEALIN’

On the Trade screen, each
player’s token is placed in one
of the Trade windows. Several
trade icons may appear in the
icon bar to the right of the
token; the Cash icon, the Get
Out of Jail Free icon, or the
Immunity icon.

NOTE: The Immunity icon appears if someone has selected that option.
A Get Out of Jail Free icon only appears for players who currently hold
this card.




TRADING CASH

To offer cash as part of a trade, click on the Cash icon of the token
offering the cash. Drop the icon in the trading window of the token
meant to receive it. A dialog box appears. Use the keyboard to enter
the cash amount. Clicking OK will enter the offer into the trading

window. Cancel will return you to a normal mouse cursor, terminating
the offer. :

TRADING TITLE DEED CARDS

To offer a property as part of a trade, move the mouse pointer over the
property on the board surrounding the trading window. Click on the
property to be offered. Drop the Title Deed icon in the trading window
of the token meant to receive it. A Title Deed may not be dropped in
the trading window of the token that owns it.




TRADING IMMUNITY

If you offer immunity, you are giving another player the right to land on
your property rent-free a certain number of times.

To offer immunity as part of a trade, click on the Immunity icon of the
token offering the immunity. Next, click the Immunity cursor on the
property square for which immunity is being offered on the gameboard
surrounding the trading window. Finally, click the icon in the trading
window of the token meant to receive it. A dialog box will appear
allowing you to select the number of turns to extend the immunity.
Select the number, and click OK to complete the offer, or Cancel to
terminate.




TRADING GET OUT OF JAIL FREE CARDS

An orange card icon, yellow card icon or combination card icon
appears only in the icon bar of tokens currently holding Get Out of Jail
Free cards.

To offer a card as part of a trade, click-on the card icon of the token
offering the Get Out of Jail Free card. Drop the card icon in the trading
window of the token meant to receive it.

GOING ONCE, GOING TWICE, GONE!

If you land on an unowned property, the Bank offers you the chance
to buy the property, or pass on it. If you pass, the property goes up for
auction, unless the Auction option is deselected. All players may
continue to bid on the property. Once no additional bids are made,

the last bidder must pay the Bank the amount bid in exchange for the
Title Deed.

During an auction, you can increase the bid by clicking one of the
currency buttons. The Bank will give other players a reasonable amount
of time to increase the bid. If no new bids are made, the property is sold

to the last bidder.

NOTE: If you offer more for a property than your available cash on
hand, the bid amount will be bracketed.

UH-OH, | OWE...

During the game, you may have to pay rent, taxes or fines. You must
pay the debt before the game can continue. If you have enough cash

to cover a debt, it will be automatically subtracted, and the game will
continue. Otherwise, you must mortgage property, sell houses, or raise
cash through a trade to satisfy the debt. If the debt can’t be paid, you go
bankrupt — and you’re out of the game.




VICTORY!

The last player to avoid bankruptcy wins!
The last player in the game receives the
cheers of the masses and the jeers of the
opponents.

INSTALLATION TROUBLESHOOTING

This section answers installation-specific troubleshooting questions. All others

will be in the online help.

Q: Why doesn’t the MONOPOLY® CD-ROM game install to my
hard disk?

A: If you are using a disk compression utility, it may distort the actual
space available. Try and free some additional disk space by deleting
unneeded files.

Q: Why doesn’t the MONOPOLY® CD-ROM game load?

A: Reinstall the MONOPOLY® CD-ROM game. Make sure that WinG
dml Win32s are selected for installation. If problems persist, restart
ows and close any other applications that are running.

TECHNICAL SUPPORT

[f you are having technical difficulties with the MONOPOLY* CD-ROM
game, please consult the README.TXT file on the CD-ROM before calling
technical support. If you call technical support, please have the following
information available (and be ready to take notes):

1. The correct name of the game.
2. The type of computer you are running the game on.
3. Your DOS and Windows version.
4. All the information after the MEM command.
5. Exact error message reported (if any).
6. The contents of your AUTOEXEC.BAT and CONFIG.SYS files.
For telephone technical support, please call (410) 568-2377. Support hours are
from 8:00 a.m. to 12:00 midnight, Eastern Standard Time, Monday through
Friday, and from 8:00 a.m. to 8:00 p.m., Eastern Standard Time, Saturday and
Sunday, holidays excluded. No game hints will be given through this number.
You may communicate with our technical support directly from the Internet or
through popular commercial online providers, such as America Online,
Prodigy, and CompuServe. Direct any E-mail questions concerning the
MONOPOLY" CD-ROM game to: HI@hasbro.com
To find out more about the MONOPOLY* CD-ROM game visit:
http://www. monopoly.com -
For information on any other Hasbro Interactive CD-ROM game, visit: y
http://lwww.hasbro-interactive.com




Intemnet MONOPOLY® CD-ROM Gameplay

You have your choice of ways to play MONOPOLY® CD-ROM on the
Internet. You must already have Internet access (see the Getting Started section).

Using the Internet/Network play feature, you can play against anyone
else with an IP address. Exchange IP address information with friends and
family for online play. (See “How to Find Your IP Address Using
Windows® 95/98” on page 6.)

You can also play head-to-head under Windows®95 using the Microsoft
Plus! add-on. For information on this product, visit:
www.microsoft.com

Looking for a Game? Is Everyone You Know Busy?

Visit the Westwood Online area of www.westwood.com for membership
information and instructions on downloading their free software. With
Westwood Online you can chat with other players, look for opponents,
and exchange IP address information.

The Westwood Online chat service is provided and maintained by Westwood Studios,
Inc. Neither Hasbro nor Westwood Studios monitors, endorses, controls or accepts
responsibility for the discussions available through this service; these discussions may be

offensive to some users or inappropriate for children. Use this service at your own risk.
Hasbro has no liability for your use of this service.

Monopoly® on the World Wide Web
Visit the official Monopoly® website at www.monopoly.com
for the latest and greatest information.
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LICENSE AGREEMENT

#0k IMPORTANT k¥

This is a legal agreement between the end user (“You”) and Hasbro Interactive, Inc., its affil-
iates and subsidiaries (collectively “Hasbro Interactive”). This Agreement is part of a
package (the “Package”) that also includes a CD-ROM disc (cn\lcctwdy, the “CD-ROM")
and certain written materials (the “Documentation”).

BY INSTALLING THE CD-ROM, YOU ACKNOWLEDGE THAT YOU HAVE READ
ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT, UNDERSTAND
THEM, AND AGREE TO BE BOUND BY THEM. YOU UNDERSTAND THAT, IF YOU
PURCHASED THE PACKAGE FROM AN AUTHORIZED RESELLER OF HASBRO
INTERACTIVE, THAT RESELLER IS NOT HASBRO INTERACTIVE'S AGENT
AND IS NOT AUTHORIZED TO MAKE ANY REPRESENTATIONS, CONDITIONS
OR WARRANTIES, STATUTORY OR OTHERWISE, ON HASBRO INTERACTIVE'S
BEHALF NOR TO VARY ANY OF THE TERMS OR CONDITIONS OF THIS AGREE-
MENT.

If You do not agree to the terms of this Agreement, promptly return the entire Package to
the place You obtained it for a full refund.

LIMITED L'ICEMI':T-SE: You are entitled to use this CD-ROM for your own use, but may not
sell or transfer reproductions of the CD-ROM or Documentation to other parties in any way.
You may use one copy of the CD-ROM on a single terminal connected to a single computer.
You may not network the CD-ROM or otherwise use it on more than one computer or com-
puter terminal at the same time.

You acknowledge that Hasbro Interactive is not responsible for the Internet or whether it
should continue to exist in its present form or whether or not a government or governmental
agency, either foreign or domestic, will control, regulate or disband the Internet.

OWNERSHIP; COPYRIGHT: Title to the CD-ROM and the Documentation, and patents,
copyrights and all other property rights applicable thereto, shall at all times remain solely
and exclusively with Hasbro Interactive and its licensors, and You shall not take any
action inconsistent with such title. The CD-ROM and the Documentation are protected
by United States, Canadian and other applicable laws and by international treaty provisions.
Any rights not expressly granted herein are reserved to Hasbro Interactive and its licensors.

OTHER RESTRICTIONS: You may not cause or permit the disclosure, copying, rent-
ing, licensing, sublicensing, leasing, disseminating or otherwise distributing of the CD-ROM
or the Documentation by any means or in any form, without the prior written consent of
Hasbro Interactive. You may not modify, enhance, supplement, create derivative work

from, adapt, translate, reverse engineer, decompile, disassemble or otherwise reduce the CD-
ROM to human readable form.

LIMITED WARRANTY:

Hasbro Interactive warrants for a period of ninety (90) days following original retail pur-
chase of this copy of the game that the CD-ROM is free from substantial errors or defects
that will marerially interfere with the operation of the CD-ROM as described in the
Documentation. This limited warranty applies to the initial purchaser only. EXCEPT AS
STATED ABOVE, HASBRO INTERACTIVE MAKES NO OTHER WARRANTY OR
CONDITION, EXPRESS OR IMPLIED, STATUTORY OR OTHERWISE, REGARDING
THIS CD-ROM. THE IMPLIED WARRANTY THAT THE CD-ROM IS FIT FOR A PAR-
TICULAR PURPOSE AND THE IMPLIED WARRANTY OF MERCHANTABILITY SHALL
BOTH BE LIMITED TO THE NINETY (90) DAY DURATION OF THIS LIMITED EXPRESS
WARRANTY. THESE AND ANY OTHER IMPLIED WARRANTIES OR CONDI-
TIONS, STATUTORY OR OTHERWISE, ARE OTHERWISE EXPRESSLY AND SPECIF-
ICALLY DISCLAIMED. Some jurisdictions do not allow limitations on how long an
implied warranty or condition lasts, so the above limitation may not apply to You. This lim-
ited warranty gives You specific legal rights, and you may also have other rights which vary
from jurisdiction to jurisdiction.




If you believe you have found any such error or defect in the CD-ROM during the warranty
period, (i) if you are in the United States, call Hasbro Interactive's Consumer Affairs
Department at 800-683-5847 between the hours of 8:00 a.m. and 12:00 midnight Monday
through Friday (Eastern Time) and 8:00 a.m. to 8:00 p.m. Saturday and Sunday, holidays
excluded, and provide your Product number; or (ii) if you are outside the United States, send
your original CD-ROM disc to Hasbro Interactive at Caswell Way, Newport, Gwent, NP9
OYH, United Kingdom, together with a dated proof of purchase, your Product number, a brief
description of such error or defect and the address to which it is to be returned. If you have
a problem resulting from a manufacturing defect in the CD-ROM, Hasbro Interactive’s entire
liability and Your exclusive remedy for breach of this limited warranty shall be the replace-
ment of the CD-ROM, within a reasonable period of time and without charge, with a cor-
rected version of the CD-ROM. Some jurisdictions do not allow the exclusion or limitation
of relief, incidental or consequential damages, so the above limitation or exclusion may not
apply to You.

HASBRO INTERACTIVE SHALL NOT BE LIABLE FOR SPECIAL, INCIDENTAL, CON-
SEQUENTIAL, EXEMPLARY OR OTHER INDIRECT DAMAGES, EVEN IF HASBRO
INTERACTIVE 1S ADVISED OF OR AWARE OF THE POSSIBILITY OF SUCH
DAMAGES. IN NO EVENT SHALL HASBRO INTERACTIVE'S LIABILITY EXCEED
THE PURCHASE PRICE OF THIS PACKAGE. Some jurisdictions do not allow the exclu-
sion or limitation of special, incidental, consequential, indirect or exemplary damages, or
the limitation of liability to specified amounts, so the above limitation or exclusion may not
apply to You.

GENERAL: This Agreement constitutes the entire understanding between Hasbro
Interactive and You with respect to subject matter hereof. Any change to this Agreement
must be in writing, signed by Hasbro Interactive and You. Terms and conditions as set forth
in any purchase order which differ from, conflict with, or are not included in this Agreement,
shall not become part of this Agreement unless specifically accepted by Hasbro Interactive
in writing. You shall be responsible for and shall pay, and shall reimburse Hasbro Interactive
on request if Hasbro Interactive is required to pay, any sales, use, value added (VAT), con-
sumption or other tax (excluding any tax that is based on Hasbro Interactive's net income),

assessment, duty, tariff, or other fee or charge of any kind or nature that is levied or imposed
by any governmental authority on the Package.

EXPORT AND IMPORT COMPLIANCE: In the event You export the CD-ROM
or the Documentation frbm the country in which You first received it, You assume the
responsibility for compliance with all applicable export and re-export regulations, as the case
II‘IEIY b{_'.

GOVERNING LAW; ARBITRATION: This Agreement shall be governed by, and any
arbitration hereunder shall apply, the laws of the Commonwealth of Massachusetts, U.S.A.,
excluding (a) its conflicts of laws principles; (b) the United Nations Convention on
Contracts for the International Sale of Goods; (¢) the 1974 Convention on the Limitation
Period in the International Sale of Goods; and (d) the Protocol amending the 1974
Convention, done at Vienna April 11, 1980.

Any dispute, controversy or claim arising out of or relating to this Agreement or to a breach
hereof, including its interpretation, performance or termination, shall be finally resolved by
arbitration. The arbitration shall be conducted by three (3) arbitrators, one to be appoint-
ed by Hasbro Interactive, one to be appointed by You and a third being nominated by the
two arbitrators so selected or, if they cannot agree on a third arbitrator, by the President of
the American Arbitration Association (“AAA"). The arbitration shall be conducted in English
and in accordance with the commercial arbitration rules of the AAA. The arbitration, includ-
ing the rendering of the award, shall take place in Boston, Massachusetts, and shall be the
exclusive forum for resolving such dispute, controversy or claim. The decision of the arbi-
trators shall be binding upon the parties hereto, and the expense of the arbitration (includ-
ing without limitation the award of attorneys’ fees to the prevailing party) shall be paid as
the arbitrators determine. The decision of the arbitrators shall be executory, and judgment
thereon may be entered by any court of competent jurisdiction. Notwithstanding anything
contained in this Paragraph to the contrary, Hasbro Interactive shall have the right ro insti-
tute judicial proceedings against You or anyone acting by, through or under You, in order
to enforce Hasbro Interactive’s rights hereunder through reformation of contract, specific
performance, injunction or similar equitable relief.
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